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Quick Start - Check List 
 

This guide has been designed to help you install and run the courseware. 

 
1.  Please understand the terms of the Software License Agreement before proceeding. 

2.  Review and check the contents of the product that you have licensed. 

 Everyone should have the following: 

   Courseware CD-ROMs. 

   Installation Disc CD-ROM. 

Installation codes for the products you have licensed 
  
 (If any of the above is missing, please contact your dealer or e-mail DynEd at support@dyned.com) 

3. As well as this User’s Guide, we have included complete manuals (in a .pdf format) on the Installation 
Disc.  This Documentation can also be accessed from within the courseware, in the Help Pull-down Menu. 

 The following manuals may be viewed on screen or printed for more detailed study: 

   The User’s Guide 

   The Records Manager Guide 

   The Network Installation Guide 

   Teacher’s Guide for DynEd’s Placement Tests 
 
You’re now set to go.  Thank you for choosing your DynEd product! 
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Accessing Documentation Before Installation 
 

DynEd has a complete set of detailed guides to help you use our products. To access these documents before 
installation, follow these simple steps.   

 

Windows 98/NT/2000/Me/XP  
1. Insert the DynEd Installation Disc CD-ROM. 

2. In the window that appears, click the Help Button.  A scrollable menu of documents will appear. 

3. Make your selection by double-clicking the desired document. 

 

Macintosh 
1. Insert the DynEd Installation Disc CD-ROM.   

2. In the window that appears, click the Help Button.    A scrollable menu of documents will appear. 

3. Make your selection by double-clicking the desired document. 

 

 

Note: These manuals are supplied in Adobe Acrobat (.pdf) format. If you do not have the required Adobe 
Acrobat Reader installed, the program will automatically install it for you (with the exception of 
Windows 98 and all Macintosh versions).  Go to www.adobe.com for all other versions. 
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Installing  the Courseware 
General Installation Information 
• Always install from the DynEd Installation Disc.  Some of the courseware discs contain installation 

files, but these should not be used.  The Installation Disc CD-ROM always has the most current programs 
and files. 

• When you install from the Installation Disc you may be asked to identify the version number of the CD.  
This information is on the label of the Courseware CD-ROMs. 

 

 
• Some products provide a choice of support language.  On these “Multilingual” products you must select 

the language you want to enable. The “All” option will allow individual users to select the support 
language when starting the Courseware.  The “All” option is not available for some products. 

• You may choose how student records are stored and managed.  See Advanced Installation Options for 
more information.  For most individual users, we suggest you choose the default options. 

• Quick/Time is required to run DynEd courseware.  The installer will check your system to ensure that a 
valid copy of QuickTime has been installed.  If not, it will offer to install it. 

• Generally, you must install the Courseware on each computer (see Non-network Installation).  However, 
for customers with networks, the Courseware requires just one installation (see Network Installation).  
For network users there are also a number of additional options for installation.  Please see the DynEd 
Network Installation Guide for more information. This manual is available in .pdf format on the DynEd 
Installation Disc. 

Version Number 

Product Name 

To install from the Installation Disc select the 
Product and Version Number that match your 
Courseware CD’s 



 
7 

 

Non-Network Installation 
Remember, you must install from the DynEd Installation Disc! 

Windows 98/NT/2000/Me/XP Installation 
 

1. Insert the DynEd Installation Disc into the CD-ROM drive. 

2. Follow the instructions in the SETUP.EXE program.  Note: You will need the Installation Codes from 
the Quick Start Guide or from your dealer. 

Macintosh Installation  
 

1. Insert the DynEd Installation Disc into the CD-ROM drive. 

2. Follow the instructions in the SETUP program.  Note: You will need your Installation Codes from the 
Quick Start Guide or from your dealer. 

Special Notes 

Product Registration 
After installation, some products must be registered to run.  To register a product, follow the instructions to 
get a Registration Code from the Internet or as directed by your dealer.  See Registering a Product. 

Advanced Installation Options 
See Advanced Options to modify some student record keeping options. 

Mastery Tests 
Please note that the Records Manager is required to access the Mastery Tests for any course.  Without a 
Records Manager, it is not possible to access the Mastery Tests.  Please see the Records Manager Guide for 
more information.  

Instructor’s Manuals 
The Instructor’s Manuals are not installed from the installation disc.  They are available to teachers through 
the Records Manager or can be downloaded from the DynEd web-site at: http://www.dyned.com/guides 



 
8 

 

Network Installation 
Remember, you must install from the DynEd Installation Disc! 

Please read the Network Installation Guide for more detailed information.   
(Note:  If you install the courses to run over a network without CD-ROMs, it is a discless install.) 

1. Insert the Installation Disc in the CD-ROM drive of one of the client machines  (Note: do not install 
directly on the server machine) 

2. Run the installation application on the Installation Disc (SETUP.EXE for Windows, and SETUP for 
Macintosh client machines) 

3. On the first screen, click Install. 

4. On the second screen, set the install path to a directory on your network. You must have all of the 
following privileges: Read, Write, Modify, Create, Execute, and Erase. 

5. Make sure there is enough hard disk space available.  For detailed disk space requirements go to 
http://www.dyned.com/network. 

6. Click Install again. 

7. Enter your Installation Code. 

8. For discless installations only, when instructed, remove the Installation Disc and insert the courseware 
CD-ROMs in the requested sequence.  Wait while the content files on the CD-ROMs are copied to your 
network.  This may take time, since there is a lot of data. Do not be concerned if the status bar does not 
move. 

9. Most networked products must be registered to run, especially if they include a Records Manager.  To 
register a product or license, you will need to get a Registration Code off the internet (or as directed by 
your dealer).  See Registering a Product on the next page. 

 

http://www.dyned.com/network
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Registering a Product 
 

Before registering a product, it is necessary to install the course, as directed in (Non-network Installation) 
and Network Installation.  Then, after installation: 

 

1. When asked if you want to register, click Register Now.  (If you wish to register later, click Later.  When 
you are ready to register, re-run the installation application on the Installation Disc and click Register.) 

2. If the computer where you are doing the installation is connected to the Internet, click Register Online, 
accept the License Agreement, and fill in the requested information.  Click Register Now, and you’re 
done. 

• If you have internet access on a different machine, go to: 
http://www.dyned.com/register 

Enter your Confirmation Code.  You will get back a Registration Code.   Enter the registration 
code on the screen, and click Submit.  

• If you do not have Internet access, contact your local sales representative. 

http://www.dyned.com/register
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Accessing Documentation After Installation  
We strongly recommend that you read the detailed documentation provided with your courseware. 

 

Windows 98/NT/2000/Me/XP 
(For courses which are already installed) 

1. Go to Start Menu / Programs / DynEd Courseware / Documents and a scrollable menu will appear. 

2. Make your selection by double-clicking the desired document. 

Macintosh 
(For courses which are already installed) 

1. Open the DynEd folder on your hard drive.  Within the DynEd folder, double-click the program 
Manuals. 

2.  Make your selection by double-clicking the desired document.  

Networks 
(For courses installed on a network server) 

1. Login to the network. 

2. From any computer on the network, double-click the DYNED directory and then double-click either 
Manualw.exe on Windows or Manual on Macintosh.  

3. Make your selection by double-clicking the desired document. 

Note: These manuals are supplied in Adobe Acrobat (.pdf) format. If you do not have the required Adobe 
Acrobat Reader installed, the program will automatically install it for you. 
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Starting the Courseware 
 

Windows 98/NT/2000/Me/XP 
1. Insert the DynEd Courseware CD-ROM into the CD-ROM drive (unless it’s a discless intallation). 

2. Click on the DynEd Courseware shortcut on your desktop.  If there isn’t a shortcut, go to Start Menu / 
Programs / DynEd Courseware and select the product you wish to run. 

Macintosh 

1. Insert the DynEd Courseware CD-ROM into the CD-ROM drive (unless it’s a discless intallation). 

2. Click on the DynEd Courseware alias on your desktop.  If there isn’t an alias, open the DynEd folder on 
your Hard Drive and double-click the Launcher application. 

Networks 
1. Make sure there are no DynEd CD-ROMs in the CD-ROM drive. 

2. Login to the network.  (For the login privileges required for each user, please see the Network 
Installation Guide.) 

3. From any computer on the network, double-click the launch application in the DYNED directory where 
the course is installed on the network (this will be either Launchw.exe on Windows or Launcher on 
Macintosh). 

4. Ask your systems administrator to create a shortcut or alias to this location for you on all computers 
using the DynEd courseware. 



 

Using the Courseware 
Entering Student Names 
The Courseware keeps records of student activity in the Student Record Keeping System.  Each student 
should have their own record. When you start the Course, select your name and choose Start, or click 
Bookmark to return to the last lesson you were in. 

If your name is not on the list, click the Add button to add your name.  If the Add button is disabled, ask your 
teacher for help.  If this is your first time to run the course, and no student names have been entered, you will 
be taken to this screen where you can enter your name. 

If your teacher has enabled passwords, you can also enter a personal password, which you will have to enter 
each time you run the course.   

Help in English 
If you click this box, all help screens and instructions in the course will be in English, even if a support 
language is available. 

Advanced Options Menu 
This pull-down menu is at the top of the screen before you enter the course. These options allow users to e-
mail their study records to their teacher, or save their records to a file.  Both options require that the teacher 
have a licensed Records Manager. 

Options Menu 
After entering a course, the Options menu at the top of the screen will show: 
Study Records: Displays Student Records.  See Student_Record_Keeping_System for more information. 
Glossary:  Provides additional examples and explanations for key vocabulary and grammar.  Not all DynEd 
courses include a glossary. 
Settings\Levels... 

Course Audio or Volume:  This enables the user to adjust the volumes of the course audio and voice 
record feature. 

• 

• Microphone: Adjusts the playback volume from microphone input. 
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Using the Courseware  
• Pause:  The language in DynEd Courseware is natural language spoken at a normal pace.  Students can 

use this setting to adjust the amount of time between sentences. 

Show Text:  (not available in most courses)  The Show Text feature causes the text to be displayed 
continuously unless the text is disabled for a lesson. To see the text, students should use the text button. 

Microphone source or Audio... (Macintosh only) - allows you to specify the source for your microphone 
and, for some courses, your CD-ROM drive. 

Help Menu 
Provides access to help screens, which explain the operation of each lesson and provide suggested study 
techniques.  The Documentation item provides access to manuals and study guides that are available for the 
course  

 

Control Bar  
 

 
Voice Record

 
Repeat 

 
Voice 
Playback  

Pause 

 

ABC 

Text  
Play 

 
Translation 

 
Rewind 

 
Exit 

 
Fast Forward 

 
Changing Courses or Modules  
Go to the File pull-down menu at the top of the screen.  Click on Change Course to switch from one course 
to another without having to exit the program.  In some courses, such as Let’s Go and Dynamic Business 
English,  you can also change Modules or Units by clicking on Change Module/Unit. 

Note:  The Changing Courses option is available for discless installations only with more than one course 
installed.  
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Student Record Keeping System 
Viewing the Study Records 
To access the Study Records, first login and start a lesson. Access to the study records is through the Options 
Menu at the top of the screen. 

Your records are displayed by lesson or by date, in a hierarchical list.  Click the arrows (Mac) or  + signs 
(Windows) to display the next lower level of records. 
 

 
The lowest level of records displays each study session, including the date and time a lesson was studied.  
There may also be a “lock” icon to indicate when a lesson has been made unavailable by the teacher (see 
Records Manager). 

For each lesson, there is a record of the time spent and Completion Percentage. The Completion Percentage 
measures how effectively a student has studied the lesson.  It tracks the kind and number of interactions with 
the program, including the number of questions answered, and the number of times a student listens and 
records each sentence.  Generally, a student should continue working within a given section of a course until 
they have achieved a Completion Percentage of 80-100% in each of the lessons of that unit or episode.  For 
more information about the Completion Percentage, please see the Records Manager Guide. 

Working with Student Records 

Individual student records can be displayed, printed and e-mailed using the following buttons. 

• E-mail - This option allows students to e-mail their study records to their teacher if the teacher has a 
Records Manager. When this option is selected, a dialog box appears asking if the student would like to 
include a message with the e-mail.  Clicking OK will ask the student for their e-mail information: 
To E-mail – Enter or edit the teacher’s e-mail address.      
From E-mail – Enter or edit the student’s e-mail address. 

 

 



 
15 

 

Student Record Keeping System 
 

CC E-mail – Enter e-mail address for someone who needs a copy of this record. 
SMTP Host Name – Set the SMTP (Simple Mail Transfer Protocol) Host Name. Typically, this will be 
something like “mail.someplace.com” where the “someplace.com” is the second half of the teacher’s e-
mail address, i.e., the part following the “@” symbol. 

 
• Print - Prints a report of records to your currently selected printer.  Records are printed as they appear on 

the screen, therefore you should arrange the screen display appropriately before selecting Print. 

Records Manager 
DynEd’s Records Manager is a tool for teachers that keeps and manages student records.  It is required for 
Mastery Tests, locking and unlocking lessons, and for assessing detailed study activities.  

For detailed information on installing and using the Records Manager, please refer to the DynEd Records 
Manager Guide on the Installation Disc. 

Completion Percentage 
The Completion Percentage is shown in the student records. It is a measure of how thoroughly a student has 
studied and practiced each lesson. A 100% Completion Percentage means that the student has completed the 
recommended amount of study for a lesson or group of lessons. 

 
Completion 
Percentage Symbol Mastery 

Test Scores Symbol 

0  0  
1-79  1-79  
80-99  80-89  
100+  90+  

 
As shown in the diagram above, the Study Records now feature a set of distinct symbols which can be used 
to quickly assess students’ advancement in either the Lessons or the Mastery Tests. 
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Tests 
 

Placement Tests  
The Placement Tests (General and Kids) come on a separate disc and may need to be installed separately.  To 
install one or both of the Placement Tests, use the Installation Disc. 
For information about the tests and how to use them, please see the manual, Teacher’s Guide for DynEd’s 
Placement Tests which is part of the documentation included on the Installation Disc CD-ROM.  

Using the Placement Tests 
After the Placement Tests have been installed, they are launched as any other DynEd product.  However, 
once a student has taken the test, it is locked.  This prevents students from taking the test more than once.  To 
unlock the test, the teacher should use the Records Manager.  Please see the Records Manager Guide to 
learn how to lock and unlock lessons and tests. 

To view Placement Test scores, use the Records Manager to view the class records for the Placement Test, or 
look at the Student Records for each student after they have taken the test and are still logged in. 

Mastery Tests 
The Mastery Tests for some courses come on a separate disc.  They require the Records Manager.  For 
information about unlocking and using the Mastery Tests, please refer to the Mastery Test Guide or the 
Teacher’s Guide for each course and the Records Manager Guide. 
After the Mastery Tests have been installed, they are launched as a part of the course.  However, the tests are 
locked to prevent students from taking them without the teacher’s permission.  To unlock a Mastery Test, use 
the Records Manager to choose a student (or group of students) and then click Edit.  Highlight the test, and 
then click Unlock. For detailed instructions, please refer to the Records Manager Guide. 
To view Mastery Test scores for a course, use the Records Manager to view the class records for that course.  
Students may see their individual scores in the Study Records.  The Mastery Test scores are integrated into 
their Study Records for the course at the end of the appropriate section of the course being tested. 



 
17 

 

Advanced Installation Options 
These options are set only during the installation process. 

 

When installing, you can select the Advanced button to modify record keeping options.  You have the 
following choices for storing student records: 

• Floppy Diskette - If your students will be using different machines each time, and you do not have a 
network, then this option should be used.  Each student is given a diskette which they must insert each 
time they run the Courseware.  Any formatted diskette can be used, and records for multiple DynEd 
products can be stored on the same diskette.  To send these records to the teacher, please see Working 
with Student Records. 

• This Directory (default) - You can install records to a directory on a local hard disk (default) or on a 
network file server.  If you have only one computer, or if your computers are not networked, then this 
directory should be left in its default location on your local hard drive.  If you have a network, see the 
DynEd Network Installation Guide for more options. 

• If you have a licensed Records Manager, you can also set an Administrator Password.  This controls 
access to the Administrator Options in the Records Manager.  Please see the Records Manager Guide 
for more information. 
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In Case of Difficulty 
Please visit http://www.dyned.com/faq for the latest support information. 

Windows  
“I don’t hear the sound.” 

If you have a sound card that was properly installed, you should be able to plug your speakers or headphones into the 
Line-Out or Speaker-Out jack on the sound card to hear the Courseware audio.  You should also hear your recorded voice 
if you use the DynEd voice recording feature. 

If things are not working as expected, please identify which of the following is true in your case: 

“I don’t hear the course audio and I can’t record my voice.” 

• Check that you have properly functioning speakers or headphones plugged into the Line-Out or Speaker-Out jack on 
your sound card, and that any volume controls or power switches on them are set correctly.   

• Check the volume control on the sound card or computer. 

• Check the Levels dialog box under the Options menu within the Courseware.  Make sure that all of the levels are set 
high enough. 

• Check your sound card.  A simple way to test your sound card is to go to the Windows Accessories window and run 
Sound Recorder.  If you are able to record your voice and play it back, your sound card is properly installed. If not, 
please contact your sound card (or computer) vendor for assistance. 

• Check that the Windows driver for your sound card has been installed.   See your sound card’s documentation for 
more information. 

“I hear the course audio, but I can’t record my voice.” 

• Check to see that a microphone is plugged into the Mic jack on the sound card, and that the switch on the microphone 
is turned on. 

• Be sure you are using the recording feature correctly.  To record, first click the record button to start recording, speak 
into the microphone, and then press the monitor (earphone) button to play back your recording. 

• Check the Levels dialog box under the Options menu within the Courseware.  Make sure that all of the controls are 
set high enough.  

“The course audio or video occasionally skips.” 

On some slower machines, audio or video can occasionally skip.  If this occurs, try one or more of the following: 

• Check that your machine meets the Minimum System Requirements. 

• Avoid running other programs while running the DynEd Courseware. 

• Contact the manufacturer of your system or video card to get the latest versions of video drivers. 

• For courses with video, set your video screen resolution to 640 by 480 and “High Color (16-bit)” mode. 

• The QuickTime settings may need to be changed.  Go to Start, then Settings, then Control Panel, then QuickTime.  
Then choose Sound Out and set it to waveOut.  If video is a problem, go to Start, then Settings, then Control Panel, 
then QuickTime. Then choose Video Settings, and set it to Safe Mode. 

 

http://www.dyned.com/faq
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In Case of Difficulty 

 Macintosh  
“I don’t hear the sound.” 

If your DynEd Courseware is working correctly, you should be able to hear the Courseware audio through your speakers 
or headphones.  You should also hear your recorded voice if you use the DynEd voice recording feature.  If things are not 
working, please identify which of the following is true in your case: 

 “I don’t hear the course audio and I can’t record my voice.” 

• Check the Levels dialog box under the Options menu within DynEd.  Make sure that all of the controls are set high 
enough. 

• Check the Sound or Monitors & Sound control panel under the Apple menu.  Make sure that you can hear the “alert 
sounds” listed there by clicking on them.  If you cannot hear these sounds, check the volume settings there on the 
control panel. 

• If you have a front-panel volume control, make sure this is turned up. 

• If you have speakers or headphones plugged into the sound-output port of your Macintosh, check to see if speakers 
are turned on and set to an adequate volume.  If you have an external monitor with built-in speakers or microphones, 
ensure that the monitor is correctly connected to the Sound-Out and Mic-In jacks on the computer. 

 “I hear the course audio, but I can’t record my voice.” 

• Ensure that you have a microphone plugged into the Microphone jack on your computer, or that your computer has a 
built-in microphone.  Remember that some monitors have a built-in microphone, but it still needs to be properly 
connected to the Microphone jack on the computer. 

• Be sure you are using the recording feature correctly. To record, first click the record button to start recording, speak 
into the microphone, then click the monitor (earphone) button to play back your recording. 

• Within the DynEd Courseware, go to the Options menu and choose “Microphone Source.”  Choose the input source 
that corresponds to where your microphone is actually plugged in. 

• On some Macintosh models, the “Microphone Source” menu may not appear.  On these machines, go to the Sound 
control panel under the Apple menu. Choose the input source that corresponds to where your microphone is actually 
plugged in.  

 “Unable to start Courseware!” 

If you get the above message when launching DynEd, it is probably because you do not have enough free memory.  To 
resolve this, do one or more of the following: 

• Exit any other running programs.  If you have been running many different programs before starting DynEd, it may 
help to restart your system to eliminate memory fragmentation. 

• Add memory to your computer. 

• Increase your virtual memory. 

 

For frequently asked questions about networking DynEd courses, please refer to the Network 
Installation Guide on your Installation Disc 

 



 

Minimum System Requirements 
 

 

Operating System Memory CPU 

Windows 98, NT, 2000, Me 
and XP 128 MB 

Pentium 300 Mhz 

MacOS X (10.2.8+) 128 MB 300 Mhz 

 

All Systems require: 

                                             • 4X CD-ROM, 16bit audio, 1000s of colors 

                                                   • Sound card and microphone 

                                             • Speakers or headphones 

 

For System Requirements updates please refer to DynEd’s website at http://www.dyned.com. 

 

 
Copyright © 1998-2006 DynEd International, Inc. All rights reserved. 

All trademarks and registered names used in this document are the property of their respective owners.  QuickTime™ 
and the QuickTime logo are trademarks used under license. 
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DynEd SOFTWARE LICENSING AGREEMENT 
 
 1.  NOTICE.  DYNED INTERNATIONAL, INC. ("DYNED") IS WILLING TO LICENSE THE ENCLOSED SOFTWARE TO 

YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS LICENSE 
AGREEMENT.  PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE CONTINUING.  BY 
CLICKING ON THE "I ACCEPT" BUTTON, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.  
IF YOU DO NOT AGREE TO THESE TERMS DYNED IS UNWILLING TO LICENSE THE SOFTWARE TO YOU, 
AND YOU SHOULD CLICK THE "I DO NOT ACCEPT" BUTTON TO EXIT.  IN SUCH CASE, PROMPTLY RETURN 
ANY AND ALL DYNED MATERIALS, ALONG WITH PROOF OF PAYMENT, TO THE AUTHORIZED DEALER 
FROM WHOM YOU PURCHASED FOR A FULL REFUND OF THE PRICE YOU PAID.  

 
 2.  Ownership and License. This is a license agreement and NOT an agreement for sale. DynEd continues to own the copy of this 

Software contained in this package and all other copies that you are authorized by this Agreement to make (the "Software"). Your 
rights to use the Software are specified in this Agreement, and we retain all rights not expressly granted to you in this Agreement. 
Nothing in this Agreement constitutes a waiver of DynEd's rights under U.S. Copyright law or any other federal or state laws or the 
Copyright laws or any other applicable laws of other nations. 

 
 3.  Permitted Uses. You are granted the following rights to the Software: 
 

(a) Right to Install and Use - Standalone Computer version. You may use the Software from any single CD-ROM on one and only 
one compatible computer at a time. You may not under any circumstance use the Software from a single CD-ROM simultaneously 
on two or more computers. You must license an additional copy of the Software for each additional compatible computer on which 
you want to use the Software from a single CD-ROM concurrently. 

 
(b) Right to Install and Use - Network version. You may install and use the Software on a single file server for use on a single (local 
or wide area) network with the Software working simultaneously on up to the number of work-stations indicated on the License 
Certificate. If you wish to use this Software on more than one network, or on a network with the Software working simultaneously 
on more than the number of workstations specified in the License Certificate, you must license additional copies of the Software. 

 
(c) Right to Transfer. You may not lend, rent or lease this Software without the express written consent of DynEd. However, you 
may transfer this license to use the Software to another party on a permanent basis by transferring this copy of the Licensing 
Agreement, the original Software, and all documentation. Such transfer of possession terminates your license from DynEd. Such 
other party shall be licensed under the terms of this Agreement upon its acceptance of this Agreement by its initial use of the 
Software. If you transfer the Software, you must remove from your computer any copy of the Software you may have made and you 
may not retain any such copies of the Software for your own use. 

 
 4.  Prohibited Uses. You may not, without written permission from DynEd: 
 

(a) Use, copy, modify, merge, or transfer copies of the Software and any accompanying documents except as provided in this 
Agreement; 

 
(b) Disassemble, decompile or "unlock", reverse translate or engineer, or in any manner decode the Software for any reason; or 

 
(c) Sublicense the Software. 

 
 5.  Limited Warranty. We make the following limited warranties, for a period of ninety (90) days from the date you acquired the 

Software from DynEd or its authorized dealer:  
 

(a) Media. The CD-ROM(s) and documentation in this package will be free from defects in materials and workmanship under 
normal use. If the CD-ROM(s) or documentation fail to conform to this warranty, you may, as your sole and exclusive remedy, 
obtain a replacement free of charge if you return the defective discs or documentation to DynEd with a dated proof of purchase. 

 
(b) Software. The Software in this package will materially conform to the documentation that accompanies it. If the Software fails to 

operate in accordance with this warranty, you may, as your sole and exclusive remedy, return all of the Software and 
documentation to the authorized dealer from whom you acquired it, along with a dated proof of purchase, specifying the problem, 
and DynEd, at its option, will provide you with either a new version of the Software or a full refund. 

 



 
22 

 

DynEd SOFTWARE LICENSING AGREEMENT 
 

(c) Warranty Disclaimer. DynEd does not warrant that this Software will meet your requirements or that its operation will 
be uninterrupted or error-free. DynEd excludes and expressly disclaims all expressed and implied warranties not stated 
herein, including the implied warranties of merchantability and fitness for a particular purpose. (These warranties give 
you specific legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction. Some 
jurisdictions do not allow the exclusion or limitation of implied warranties, so the above exclusion or limitation may not 
apply to you. In that event such warranties are limited in duration to the warranty period. No warranties apply after that 
period.) 

 
 6.  Charges and Taxes. DynEd does not give refunds or credits for charges already due or paid. If any authority imposes a duty, tax, levy 

or fee, excluding those based on DynEd's net income, upon the Software supplied by DynEd under this Agreement, then you agree 
to pay that amount as DynEd specifies or supply exemption documentation. 

 
 7.  Limitation of Liability. DynEd's liability to you for any losses shall be limited to direct damages, and shall not exceed the 

amount you originally paid for this Software. In no event will DynEd be liable for any special, incidental, or indirect 
damages or for any economic consequential damages (including lost profits or savings), even if DynEd, or its reseller, has 
been advised of the possibility of such damages. Some jurisdictions do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. 

 
 8.  Disclaimer of Liability for Hosting in DynEd Servers: DynEd disclaims all liability for any and all damages, including direct, 

consequential and incidental damages, arising out of the failure or inability of DynEd to maintain access to the DynEd servers in 
accordance with this agreement, including, but not limited, losses or damages resulting from the loss of your business, loss of data or 
service as the result of delays or service interruptions. 

 
 9.  United States Government Restricted Rights. The enclosed Software and documentation are provided with Restricted Rights. Use, 

duplication or disclosures by the U.S. Government or any agency or instrumentality thereof is subject to restrictions as set forth in 
subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at 48 C.F.R. 252.227-7013, or in subdivision 
(c)(1) and (2) of the Commercial Computer Software - Restricted Rights Clause at 48 C.F.R. 52-227-19, as applicable. Contractor 
Manufacturer is DynEd International, Inc., 1350 Bayshore Hwy., Suite 850, Burlingame, CA 94010. 

 
 10. Export Controls. You agree that you will not directly or indirectly transfer the Software or documentation to any country where such 

transfer would be prohibited by the U.S. Export Administration Act and the regulations issued thereunder. 

 
 11. Termination. This license and your right to use this Software automatically terminates if you fail to comply with any provisions of 

this Agreement, destroy the copies of the Software in your possession, or voluntarily return the Software to DynEd. Upon 
termination you will destroy all copies of the Software and documentation. 

 
 12. Miscellaneous Provisions. This Agreement will be governed by and construed in accordance with the substantive laws of the state of 

California. This is the entire agreement between you and DynEd relating to the contents of this package, and supersedes any prior 
purchase order, communications, advertising or representation concerning the contents of this package. No change or modification 
of this Agreement will be valid unless it is in writing and is signed by DynEd. The governing language of this agreement shall be 
English. 
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